
BEST CASE® BANKRUPTCY
Advanced Topics
This educational guide provides you an in-depth 
look at practical solutions and workflow tools 
in Best Case Bankruptcy. Get an inside look into 
advanced features and functions with helpful  
screen shots, step-by-step instructions and tips.
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Client and Case Management

Create Client Templates
The Client Templates feature allows users to create new 
client files with similar standard information pre-populated. 
There is no limit to the number of templates you can create.

To create a Client Template: 
1.	 Open the Client List, click on the Filter drop-down and 

select Templates for New Clients. 
2.	 Click the New Client button located at the bottom of the 

Client List and enter information.
3.	 Click OK.
4.	 Double-click the template file you created to further 

customize forms and schedules.
5.	 To create a client file, click New Client and select the 

template you wish to use.

	� Note: Changes you make to a new file will not affect  
the template, and changes you make to the template 
won’t affect an existing client file.   

Create a Client Template to make quick work of setting up a new 
client file. .

Enter basic information that is common among clients in the Create 
NEW Template Client window and click OK.

Set Up Similar Client Files in Less Time

Track and Manage Clients More Effectively

When defining fields, enter a description in the Field Tip Text box and 
the description will appear when you roll your mouse over the field. 

Create Custom User-Defined Fields
There are four types of fields available for customization 
depending on your needs. Choose from: 

To access User-Defined fields:
1.	 Open a client file and click the Notes button on the toolbar
2.	 Select the tab labeled User Defined 1
3.	 Click Edit Field Prompts to create a name for the field
4.	 Select the appropriate field type from the 4 choices above
5.	 Enter the new field name into the Field Prompt Text box

The Field Tip Text box produces text that appears when a 
Best Case user’s mouse hovers over the field.

Note: To remove unused User-Defined Fields enter a  
tilde (~) in the Field Prompt Text box.

Add Detailed Notes to a Client File
To insert a more comprehensive note or reminder:  
1.	 Open a client file and click the Notes button
2.	 Click Insert and the Notes Form dialog box opens
3.	 Enter a Subject and User Name
4.	 Type a message in the Notes window and click OK 

■■ Text fields
■■ Date fields

■■ Amount fields
■■ Check box fields

TIP
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Client and Case Management

Keep Track of Case Events
Important Dates Tab 
Based on the debtor’s expected filing date, Best Case 
generates a list of important events and their corresponding 
deadline dates, including: 
■■ The first available date for Credit Counseling  

(180 days before the filing)
■■ The period for payment advices (60 days prior to  

the filing) 
■■ The last day to provide tax returns to the U.S. Trustee  

(7 days after filing)
■■ The last day for the U.S. Trustee to file a motion to 

dismiss for abuse (30 days after filing)
■■ And much more

Send Dates to Calendar
You can export important dates from Best Case to Outlook 
or other iCalendar-compatible software to help keep you 
current with upcoming case events.

1.	 Choose dates to export from the Case Status, User 
Defined or Important Dates tabs

2.	 Select the To Calendar button at the bottom of the 
window

3.	 Check the events you want to export

4.	 Click Send to Calendar at the bottom of the window

Note: For Send to Calendar to work properly, Outlook 
or iCalendar must be open and running. You may be 
prompted to link your external calendar to Best Case on 
your first Send to Calendar export.

Deadline dates help you identify critical upcoming events and 
required documents.	

Selecting Important Dates to export begins with just a couple clicks 
in the Case Status, User Defined or Important Dates tabs.

Once you check the dates to export, one click sends the dates to 
Outlook or your iCalendar-compatible calendar. 
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Client and Case Management

Client Filtering and Reporting

Filtering Client Files
A drop-down filter menu can be used to filter cases according 
to specific information which is entered into the Notes window 
of each Client. Select one of the following to display:
■■ Active: Cases with a status set to Active
■■ Closed: Cases with a status set to Closed
■■ Prospect: Cases with a status set to Prospective Client
■■ All: All cases
■■ Needs Attention!: Clients with the Needs Attention 

checkbox checked
■■ Follow-up Date: Cases with a Next Follow-up date entered
■■ File Date: All clients with a Date Filed entered
■■ 341 Meeting Date: All clients with a 341 date entered
■■ Confirmation Hearing Date: Clients with a date entered in 

the Date Confirm Hearing field
■■ Confirmed Date: Clients with a date entered in the Date 

Plan Confirmed field
■■ Discharge Date: Clients with a date entered in the Date 

Discharged field
■■ Dismissed Date: Clients with a date entered in the Date 

Dismissed field
■■ Various Dates by Ranges: Filter clients by a date range 
■■ Case Number: All clients with a Case Number entered in 

the Case Status Tab
■■ Office Number:  All clients with an Office Number on the 

File Setup Information Tab
■■ Templates for New Clients: Lists all current Client 

Templates

■■ Index
■■ Debtor Name
■■ SSN
■■ Address
■■ Phone

■■ Email
■■ Employer
■■ Case Number
■■ File Number
■■ Attorney Name

■■ Paralegal
■■ Referred By
■■ Comment
■■ Disk File Name 

Search Files within the Client List
Use the Search button in the top right corner of the Client List 
window to search the entire Client List. Categories include:

1.	 Select a drop down search category from Find Item 
2.	 Enter your desired search criteria in the Find Text field 

and click Search.
3.	 The client(s) that match your criteria are displayed. In this 

window you are able to open the client file, print or copy 
the results list, start a new search or close the window.

Select a filter drop down to display only certain client files.

Select the category, enter text to locate, and click Search.
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Client and Case Management

Search for Files within a Filtered Client List
Refine a filtered list one step further by searching for a 
particular client name or office file number.
1.	 Open the Client List window and filter by name
2.	 Type two exclamation points !! and then type the name 

you want to find

Note: Do not enter a space after the exclamation points

3.	 You’ll see the text you typed at the top of the Client List 
window, next to the Filter field

4.	 As you type, your Client List will be filtered to include the 
files that meet your search criteria

Note: Use this search method in: All Clients, Active 
Clients, Closed Clients, and Prospective Clients.

Create a Client List Report
From the Client List window, you are able to generate a 
report based on various criteria and filters.
1.	 Click Report in the upper right-hand corner of the  

Client List window
2.	 Choose from the following options:

■■ Print Client List for Current View Filter: Displays all 
debtors in your current filtered Client List window

■■ Print Client List for Range Filtering: Displays client 
files based on a range of criteria including Debtor 
Type, Chapter, Case Number, Needs Attention, 
Jurisdiction, Case Status 

■■ Print Client List and Range Filtered: Displays all 
debtors in your current filtered Client List window and 
specific filtered criteria

■■ Print Client Summary: Displays a yearly summary 
of cases by Total Cases, Active, Closed, Preparing 
to File, Ready to File, Filed/Pre 341, Post 341, Pre 
Confirmation, In Plan, Discharged, Dismissed, Inactive, 
Chapter 7, 9, 11, 12, 13 and 15, Individual, Joint, 
Partnership, Corporation, or Other type.

■■ Export Client List to .CSV File: Prepares a file with 
all clients or specific clients based on your filtered 
criteria.

When your Client List is filtered, you can further refine your search 
with a partial or full name. 

Customized reporting features allow you to export your client list 
with various criteria. 

Client List Filters help narrow down your client list to specific cases; 
choose to include all clients or various filters.
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Download Electronic Credit Reports into Best Case
The Best Case Credit Report Import feature provides an easy, convenient, and fast way to enter claims directly on the creditor 
schedules without leaving Best Case. All electronic credit reports contain creditor names, addresses, account numbers and more.

Order a Credit Report

Click Order Reports Now, and you are ready to authenticate  
the debtor.

1.	 Open a client file
2.	 Select Credit Report from the top menu bar or from the 

Tools drop-down menu
3.	 Select Credit Reports for this Client
4.	 The Credit Report Order Wizard prompts you to order

Authenticate a Client
1.	 Click Authenticate
2.	 A web page will load with a short series of multiple choice 

questions which only your debtor can answer 
3.	 If your debtor’s identity has already been authenticated, 

select Already Authenticated

Download Credit Reports 
1.	 Select Download Reports
2.	 The report downloads and is ready to be imported into  

Best Case 

Import into Best Case
1.	 Select Import Reports to Best Case
2.	 Choose to import all debts to Schedule F or select a 

schedule for each debt
3.	 To import all debts to Schedule F, click the Tag All as  

Sch F button at the top of the window, then click the 
Import to Client button

4.	 To select a schedule for each debt, highlight a creditor 
record and press D, E, F or G on your keyboard or use the  
Sch D, Sch E, Sch F or Sch G button at the top of the window 

Note: For Schedule E claims, you’ll need to select the type 
of priority for each debt 

5.	 Select the appropriate schedule for each creditor 
6.	 Click Import to Client when you have marked each record 

that you want to import

Click Import Reports to Best Case to transfer data to Schedules.

To omit claims that have 
been paid and have a $0.00 
balance OR to show claims 
with only an open status, 
check the appropriate box 
in the lower left corner.

To Get Started
Set up an account with one or all three of our credit report partners:
■■ A Suite Solution	 877.311.1234	 www.asuitesolution.com
■■ CIN Legal Data Services	 866.218.1003	 www.cinlegal.com
■■ CoreLogic® Credco	 877.213.6520	 www.corelogiclegal.com/software

Workflow Efficiency Tools – Credit Report Import

TIP
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Workflow Efficiency Tools – MyCaseInfo® 2.0

Streamline the Initial Data Collection and Entry Process
Available for Chapter 7 and Chapter 13 consumer cases, MyCaseInfo helps you collect bankruptcy-specific information from 
clients with a web-based questionnaire. It allows you to preview the clients’ responses and download the data into Best Case. 

How to Access MyCaseInfo

Simply click Import to download data into a new client file or only 
import specific sections into an existing client file.

1.	 Select MyCaseInfo from the Tools drop-down menu
2.	 Select Attorney Administration site

Invite a New Client
1.	 Select the Invite a Client button in the left side bar 
2.	 Complete basic information and choose what questionnaire 

sections you want your client to complete including Debts, 
Expenses and more

3.	 Click Send. An email is sent inviting your client

Client Experience 
Once your client logs in, they get detailed instructions and 
access to helpful tools and videos. Questions are formulated to 
be simple and easy to understand. When completed, an email 
will be sent notifying you that your client has completed the 
questionnaire.

Preview and Download the Case Data
1.	 Go to the Attorney Administration site and find the client
2.	 Preview all client-entered data
3.	 To download, click Purchase
4.	 Save the file to your desktop 

Import into Best Case (New Client)
1.	 In Best Case click New
2.	 Click Import to download and create a new client file

Import into an Existing Client File
1.	 In Best Case, open the client file and click Tools/

MyCaseInfo/Import MyCaseInfo into currently open 
client file

2.	 Browse to the MyCaseInfo file and click Open
3.	 Eight check boxes allow you to select what information you 

would like to include or exclude from the download
4.	 Click Import to download the data into the existing client file

To Get Started
1.	 Complete the Online Request Form at  

www.bestcase.com/mycaseinfo/signup
2.	 Invite as many clients as you want but only pay for the 

downloaded client files
3.	 You’re billed $6 per import in one monthly payment

To invite a client to use MyCaseInfo, enter the instructions for the 
information you need and click Invite New Client.

Review client progress at any time and preview all data entered 
for accuracy prior to purchasing and downloading.

First 

Import is 

FREE
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Additional Documents Library

You can produce custom documents for your Additional 
Documents Library, to easily generate custom motions, client 
letters, creditor letters, envelopes and more. Information 
entered in Best Case can be merged into a document in your 
word processing software to customize the piece.

Best Case comes with several Additional Documents, but it also  
gives you the option to build customized Additional Documents.

Edit an Existing Additional Document 
1.	 Highlight an existing document in the Additional 

Documents Library and press Ctrl+E 
2.	 Select either Microsoft Word or Word Perfect
3.	 Click Edit ADL

Note: You will see several instances of text similar to 
{MERGEFIELD xxx}. This is where Best Case merges the 
unique information.   
Example: {MERGEFIELD DateFiled} will load the date the  
case was filed. {MERGEFIELD DbtLastName} will load the 
debtor’s last name.

4.	 Edit the body of the letter to use the existing merge fields
5.	 To overwrite the existing client letter, click Save and the 

next merge will include the changes 

Add as a New Additional Document 
1.	 Under the File menu select Save As and rename the file. 
2.	 When adding a new Additional Document, save the file in 

the BESTCASE\Adl_ms\ folder. Give the document a new 8 
letter name with the file extension of “.wfm”. In the Save As  
screen, place quotation marks around the 8 letter file name  
and .wfm extension or MS Word will add its own file extension.

3.	 In the Additional Documents Library, click Insert to insert 
the new Additional Document. Enter in the 8 Letter File 
name (not including the .wfm extension) in the top right 
and select the data source.

4.	 Double click on the document to ensure information 
merges properly.

Data Source and Merge Code Information
Best Case has a variety of information to choose from, based 
on the data source you select. Information such as the claim 
amount for a particular creditor, the case number, and more 
can be selected. Merge codes vary by the data source used, so 
please note the data source of the document from which you 
will base the new Additional Document.

Data Source Notes
Voluntary Petition Information: Includes all debtor 
information listed on the Voluntary Petition, Attorney 
Compensation Statement, Application to Pay Filing Fee in 
Installments, and information from the Client Notes section  
for the open client file, as well as some information from 
Schedule I and the Chapter 13 Plan Calculator.

Pick One Creditor: Complete with Voluntary Petition 
Information, which contains the name and address of any 
creditor selected plus debtor information contained in the 
Voluntary Petition data type above.

Pick Multiple Creditors, Contracts or Codebtors, Complete 
with Voluntary Petition: Same field codes as the Pick One 
Creditor data type, but allows you to select more than one 
party from Schedule D, E, F, G or H and creates a separate letter 
or form for each party. It also allows you to choose any of the 
additional notice parties.

All Creditors and Others on Master Mailing Matrix: Name, 
address, and account number, which contains the names and 
addresses of all creditors in the case, along with any additional 
notice parties, without debtor information.

All Creditors and Others on Master Mailing Matrix 
Complete with Voluntary Petition Information: Provides 
the names and address of all creditors and additional notice 
parties, along with debtor information in the Voluntary Petition  
data type above.

Client List Information: For all clients, this data type gives 
information from the Client Notes section of the program 
and selected information from the Attorney Compensation 
Statement and the Chapter 13 Plan Calculator.

Create Custom Client Letters, Motions and More
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Chapter 13 Plan Calculator

Assign Classifications to Creditors
Each portion of each claim must be given a payment 
classification by the user.  

Assign classifications in the 13 Plan Treatment Tab in the 
creditor information entry screen for each claim. 

Commonly Used Plan Classifications
Selecting the appropriate classification is necessary for the 
Chapter 13 Plan Calculator to effectively calculate your plan. 
■■ Secured Fixed Payment – Input the term and interest rate
■■ Secured Paid Prorata – Input the interest rate
■■ Secured Long-Term Inside Plan – Input the term and  

interest rate 
■■ Secured Long-Term Outside Plan – Input the term and 

interest rate 
■■ Arrearage Fixed Payment – Input the term and interest 

rate
■■ Arrearage Paid Prorata – Input the interest rate
■■ Unsecured General Non-Priority 
■■ Unsecured Priority
■■ Unsecured, special class, paid 100% 

Calculating a Chapter 13 Plan
1.	 In the Summary Tab, insert a question mark into the 

payment field and declare the term of the plan in the 
corresponding term field

2.	 Click Calculate in the bottom left hand corner
3.	 Best Case calculates a feasible Chapter 13 Plan payment 

based on the criteria entered

Calculating a Step Plan
1.	 Enter the monthly payment amounts for each step, along 

with the number of months
2.	 Type a question mark for the number of months or 

payment of the last step
3.	 Click Calculate
4.	 A possible payment plan is calculated for the remaining 

step of the plan

Additional Chapter 13 Tabs:
Claims Tab: Lists each claim, the 13 Plan Classification, 
payment ranking, beginning and ending months, total amount 
to be paid, interest accumulated, and total claim amount. 
Payout Tab: Lists each individual payment to a particular 
creditor throughout the life of the plan organized by month 
Liquidation: Estimates a scenario for filing a Chapter 7 case 
Split Claim: Itemizes any split claims for the 13 Plan
Wage: Enter wage deductions for your debtor and joint debtor 
Limits: Compares the totals for the case with the limits from 
11 USC § 109(e)

Enter lump sum payments then calculate in the Summary Tab.

Overview of calculating a Chapter 13 plan in Best Case
The Best Case Chapter 13 Plan Calculator helps you develop a workable plan; it performs various calculations including the 
minimum monthly payment needed to repay creditors or the number of months needed to repay creditors, and then displays 
how the funds will be distributed.

TIP
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Workflow Efficiency Tool – MyECMail

ECF Calendar: Upcoming case-related events auto-populate  
the ECF calendar and can be exported.

To Get Started Using MyECFMail

1.	 Attend a FREE product seminar 
Register at www.bestcase.com/memdemo

2.	 Sign up for a FREE 30-Day Trial 
Visit www.bestcase.com/memdownload

MyECFMail Email Manager: Read case emails, access Free Look 
PDFs, filter by case number, debtor name and more.

Case Viewer in Best Case: Click a tab to instantly view Docket Text, 
Proofs of Claim or calendar events. 

The CM/ECF Email Manager, Calendaring 
and Case Management Solution that works 
seamlessly with Best Case

Available as an add-on workflow tool to Best Case, 
MyECFMail automates the bankruptcy ECF process by 
downloading your Free Looks, posting bankruptcy events 
to the built-in ECF calendar and providing access to these 
communications in Best Case Bankruptcy. 

How MyECFMail Works
There are three main components to MyECFMail:
1.	 Email Manager— This houses all your incoming ECF emails.

■■ View summary information of each case including case 
number and all case PDFs

■■ Automatically downloads and saves your Free Looks 
eliminating unnecessary and costly trips to PACER

■■ View, sort and filter based on a variety of criteria

2.	 MyECFMail Case Viewer— View CM/ECF activity for a 
client right in Best Case Bankruptcy
■■ Docket Report Tab – View case emails and PDFs
■■ Proof of Claims Tab – Displays Proof of Claims 

including claim name, address and amount
■■ Calendar Events Tab – Lists events and meetings 

including location, date and time

3.	 ECF Calendar— Bankruptcy-specific events are 
automatically populated to the built-in calendar
■■ Auto-populates General Hearing, Discharge  

Deadlines, 341 Meeting, Confirmation Hearing and 
Continued Hearing

■■ Assigns rules and alarms to remind you of  
upcoming events 

■■ Easily export calendar information to Outlook or other 
iCalendar-compatible software
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Workflow Efficiency Tool – MyECFMail

Create a Custom Filter
1.	 Click the + green button in the Filters window
2.	 Enter the filter name and click the Add button.

Apply a Custom Filter to an Email
1.	 Right-click on the email that you want to apply the filter 

and select Add Filter.
2.	 A sub-menu listing all currently created filters will appear. 

From this menu, select the Filter that you would like to 
apply to the email.

Create customized Calendar Rules to auto populate events specific 
to your jurisdiction.

If you are importing items into Google Calendar, choose .CSV,
Outlook users choose .ICS.

Keep organized by applying custom filters to emails.

Defining Calendar Rules
A customized rule creates an event in the MyECFMail 
calendar whenever keywords or phrases you define are found 
in the Docket Text of an email. 

Note: Customized rules operate to the principles of 
Boolean logic: AND, OR, and NOT. 

1.	 In the top menu bar, go to Setup, then Manage Rules
2.	 Click Add to create a new Calendar Rule
3.	 Complete the following fields:

■■ Rule Name: As listed in the Calendar Rules List
■■ Event Title: The title of every event the rule creates
■■ Keywords: Enter the keyword(s) for which this rule 

will search for in the Docket Text of the email. 

Note: Separate keywords in a single rule with a semicolon(;)

■■ AND: Enter any words or phrases in addition to the 
Keywords section. This field can be left blank.

■■ Exclude: Enter any word or phrase that provide an 
exception to the rule. This field can be left blank.

■■ Event Description/Body: The description of every 
event this rule creates. This field can be left blank.

Note: If the time of an event is unable to be determined, it 
will be populated at 5:00 AM on the date of the event.

Export the ECF Calendar 
Easily export the MyECFMail Calendar data so you can 
transfer events into your daily calendar.
1.	 In the top menu bar, go to Tools, then Calendar Export 

Wizard
2.	 Choose between two file types: Comma Separated 

Variable (.CSV) or iCalendar (.ICS) format
3.	 Select a date range, click Next
4.	 Choose a location to save the file, click Save
5.	 Click Close once the export file is created
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Keys Action

Esc Go back a screen 

Ctrl + C Copy

Ctrl + X Cut

Ctrl + V Paste

Ctrl + Z Undo

Tab Move forward from field to field

Shift + Tab Move backward from field to field

F1 Opens context-sensitive help

Ctrl + \ Opens spell check

Client List

Ctrl + O Opens the Client List Window

Ctrl + Shift + N Access Client Notes Screen

Ctrl + Shift + R Rebuild the Client List

↑ ↓ Open a Client file. Highlight with arrows and click enter

Forms and Schedules

A-J Opens a Schedule: Choose corresponding letter

1 Opens the Voluntary Petition

4 Opens Form 4

6 Opens the Summary of Schedules

7 Opens the State of Financial Affairs

8 Opens the Chapter 7 Individual Debtor’s State of Intention

3 Opens the Chapter 13 Plan Calculator

Ctrl + Shift + J Opens the Jurisdiction Window

Ctrl + Shift + K Opens the Form Preference

Ctrl + Shift + P Opens the Best Case Standard Preferences

Alt + Enter Add new items to a schedule in an entry screen.

Accelerator

Alt + underline letter Jump to a question that has one letter underlined

Printing

B  + Spacebar Select the form with  
the arrow key, then 
click the spacebar 
to print

Shift + Spacebar To select all forms 

Ctrl + P To print the  
selected forms

Best Case Online Tools
Access a suite of online tools to help calculate 
dates and formulas instantly.  

Quick Median Income Test
Enter the debtor’s state, household size 
and average gross monthly income and the 
debtor will be compared to the state median 
income for the household size. If the debtor 
is under the median income the results will 
be in green and if they are over the median 
income the results are in red.

Date Calculator
Add or subtract days, months and years to a 
specified date to identify time spans for the 
Statement of Financial Affairs, eligibility for a 
Homestead Exemptions Limit, etc. 

Between Dates Calculator
Enter a date range and quickly get the 
number of days between them. This is ideal 
for identifying the financial management 
requirement (180 days), etc.

Holiday Calculator
Enter a specific year (ie 2011) and the 
calculator will automatically return a list of 
the observance dates of all Federal Holidays 
for that year. 

Visit: www.bestcase.com/onlinetools 
or access directly from the Tools Menu.

Wolters Kluwer Law & Business connects legal and business communities with timely, 
specialized expertise and information-enabled solutions to support productivity, accuracy 
and mobility. Serving customers worldwide, our products include those under the Aspen, 
Best Case, CCH, ftwilliam, Kluwer Law International, Loislaw, MediRegs, and TAGData names.

For more information call 1.800.492.8037 or visit www.bestcase.com


